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Take Control ebooks help readers regain some measure of control in an 

oftentimes out-of-control universe. Take Control ebooks also streamline the 
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READING AND PRINTING TIPS 

We designed this ebook to be read online or printed. Here are a few 
tips to help you get the most out of your reading experience. 

Online reading tips: 

(We’re still learning the tricks for Panther’s Preview application, so 
these are primarily for Adobe Acrobat and Adobe Reader.) 

• In Adobe Acrobat 5, the Take Control default settings on the View 
menu are Fit in Window and Continuous. For most people with 
larger monitors, those should be fine. To focus only on reading, in 
Acrobat 5, choose View > Full Screen, or in Acrobat 6, choose 
Window > Full Screen View. (Press Esc to leave full screen mode.) 

• Increase the size of the text by clicking the window’s Zoom button to 
make the window as wide as possible, then choose View > Fit Width. 

• To scroll using keyboard shortcuts, you must first click the main 
text area. The Page Up and Page Down keys may be the easiest 
(and they scroll by screen when you view less than a full page). The 
Left and Right arrow keys scroll to the previous and next page 
starts.  

• Blue text indicates links. You can click any item in the Table of 
Contents to jump to that section. Cross-references are also links, as 
are URLs and email addresses. 

• Work with the Bookmarks tab showing so you can always see and 
jump to any main topic by clicking the associated bookmark.  

• You may experience a display problem wherein the top border on 
tip and screenshot layouts does not appear. The borders should 
print properly and may show properly at a different view 
percentage. They also appear correctly in Apple’s Preview. 

Printing tips: 

• In the unlikely event that Adobe Acrobat or Adobe Reader cannot 
successfully print this PDF, try Apple’s Preview; several readers 
have solved printing problems by using Preview. 

• If you prefer a tighter layout that uses fewer pages, check your 
printer options for a 2-up feature that prints two ebook pages on 
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one piece of paper. For instance, your Print dialog may have an 
unlabeled pop-up menu that offers a Layout option. Choose 
Layout, then choose 2 from the Pages per Sheet pop-up menu. You 
also may wish to choose Single Hairline from the Border menu. 

• When printing on a color inkjet printer, if you want to avoid using 
up a lot of color ink (primarily on the yellow boxes we use for tips 
and figures), look for an option to print entirely in black-and-
white. 

  
FUTURE 

UPDATES 
TidBITS Electronic Publishing may publish minor updates to this 
ebook to account for errata, software updates, new information, or 
other reasons. Such updates will be offered at no extra charge; notifi-
cation will go to the email address you gave at the time of purchase.  

  
 

This is a free sample of “Take Control of Users & Accounts in Panther.”
Click here to buy the full 65-page book for $5!

http://www.tidbits.com/takecontrol/panther/users.html


 

Page 5 

INTRODUCTION 

Apple has done an excellent job of hiding many of Mac OS X’s Unix 
underpinnings, so Unix-related features such as preemptive 
multitasking just make the Mac work better than ever before, without 
drawing attention to themselves. But other aspects of that Unix 
foundation do affect the way we work in important and noticeable 
ways; for example, Unix brings a full multi-user operating system to 
OS X, which means that each person who wishes to use the Mac must 
use it while logged into an account.  

This ebook goes much further than just telling you how to set up and 
configure user accounts. I explain the different types of accounts, how 
to limit the capabilities of certain accounts, and what you need to 
know about Fast User Switching. I also explain why you should have 
at least two accounts even if no one else uses your Mac. 

By the end of this ebook you’ll be able to take control of all your 
accounts—whether you have one or dozens—and work more 
efficiently with Panther. 

Terminology and Conventions 
In reading this ebook, you may encounter a few unfamiliar terms and 
conventions. To get the most out of this ebook, please note the 
following: 

Permissions: I talk about permissions often in this ebook. 
Permissions are special bits in files and folders that tell your Mac who 
owns a file; what rights they have: read (view a file, open a folder, or 
access an application), write (view a file and save changes, or create 
new files in a folder), execute (launch a program); and what others 
can do with the item.  

Authenticate: This is a fancy word that means “enter your user 
name and/or password.” The login window, which appears when you 
log into your Mac, is an authentication dialog. You’ll also see an 
authentication dialog if you have an administrator account and try to 
access, change, or delete certain files, or perform other tasks, such as 
installing some software. 
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Path syntax: This ebook occasionally uses a path to show the 
location of a file or folder. Path text is formatted in bold type. A path 
is the location of a particular item in your file system. For example, 
Panther stores most utilities, such as Stuffit Expander, in the Utilities 
folder. The path to Stuffit Expander is: 
/Applications/Utilities/StuffIt Expander.  

The front slash at the start of the path tells you to start from the root 
level of the disk.  

You will also encounter paths that begin with ~ (tilde). The tilde is a 
shortcut for any user’s home directory. For example, if a user wants to 
install fonts that only he can access, he would install them in his 
~/Library/Fonts folder, which (to a user named kirk) is just 
another way of writing /Users/kirk/Library/Fonts. 
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WORKING WITH ACCOUNTS QUICK START 

User accounts affect almost everything you do under Mac OS X. You 
must have at least one account, and, if you need to create additional 
accounts, you can do so easily. Here’s an overview of how this ebook 
will help you work with accounts in Panther: 

Learn about accounts: 

• Learn what user accounts are, and why you need them. See About 
User Accounts. 

• Discover what has changed with accounts from Jaguar to Panther. 
See What’s New with Accounts in Panther.  

• Find out about five types of user accounts; see Types of Accounts. 

• Learn strategies for setting up accounts for situations that you may 
not have previously considered, such as for troubleshooting or 
visitors. See Choose an Account Strategy. 

Create and delete accounts: 

• Set up and configure a new account; see Set Up an Account. 

• Delete accounts when you need to; see Delete an Account. 

• If desired, activate the root account; see Activate the Root Account. 

Work with accounts: 

• Log in and out of your account, plus customize options to simplify 
or secure the login process. See Log Into and Out of Accounts. 

• Use Fast User Switching to share your Mac more efficiently. See 
Fast User Switching. 

• Add and remove user startup items; see Manage Startup Items. 

• Use your knowledge of user and system startup items to perform 
basic troubleshooting. See Troubleshoot Startup Items. 

Share files among users: 

• Choose from one of four methods for sharing files among users on 
the same Mac, and set one up. See Share Files among Users. 

• Share music and photos; see Appendix A: Share Digital Media Files. 
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ABOUT USER ACCOUNTS 

User accounts are at the heart of any Unix-based operating system, 
including Mac OS X. The entire system relies on this concept, so 
having a basic understanding of what accounts are and why you need 
them will help you better comprehend and use Mac OS X. 

Since Unix-based operating systems rely on the concepts of 
permissions and ownership, each file, folder, and application must 
belong to a specific user. For this to be the case, users must be 
declared and identified; hence the idea of creating unique accounts 
for each user, much as every customer of a bank has their own 
account that no one else can access. 

When you set up or receive an account on Mac OS X, you become a 
user of that computer, and you are assigned a home folder (the folder 
with your name and the house icon). Your home folder is the 
receptacle for your personal files, and, under Mac OS X, it contains a 
number of sub-folders that help you further organize your files. 

Because your files belong to you, other users cannot access files 
contained in the sub-folders of your home folder; this is also true in 
the other direction: you cannot access files in other users’ folders. To 
help users on the same Mac share files, each home folder contains a 
Public folder, from which any user can copy files, and this folder 
contains a Drop Box folder, into which any user can copy files. 

This multi-user focus is quite different from earlier versions of the 
classic Mac OS, which generally assumed that any user of the 
computer could access all its files. You could set up multiple users for 
file sharing over a network, but for the most part, you couldn’t limit 
what other users of the same computer could do. In particular, you 
could put files anyplace on the computer, and anyone could access 
them when they started working on the Mac. 

In addition to this segregation of files among users, Unix-based 
operating systems prohibit standard users from accessing, changing, 
or deleting essential system files. This prevents standard users from 
damaging the operating system. Administrators, however, can access 
all files on a computer. You’ll learn more about this distinction later, 
in Types of Accounts. 
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TYPES OF ACCOUNTS 

Panther offers four normal types of accounts: administrator accounts, 
standard accounts, managed accounts, and simplified accounts.  

There is also a special fifth type of account, called root, which is not 
accessible from the Accounts preference pane. You can see the types 
of accounts set up on your Macintosh by viewing the Accounts pane in 
System Preferences, as shown in Figure 1. (To open System 
Preferences, choose it from the Apple menu or click its icon in the 
Dock.) 

FIGURE 1 

 

A quick look at the left side of the 
Accounts pane in System 
Preferences reveals which accounts 
are set up on the Macintosh. You 
can easily see the user name for 
each account and which type of 
account it is: admin, standard, 
managed, or simplified. 

 Before you start creating new accounts, you need to understand these 
different account types, what rights each one has, and how you would 
use each type. Table 1, next, summarizes the powers and limitations 
of these accounts; the rest of this section explains the account types in 
more detail. 

  
NOTE Technically speaking, managed and simplified accounts are merely 

variants of standard accounts, but I follow the example of the 
Accounts preference pane, which uses all three terms in its interface. 
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FAST USER SWITCHING 

Inspired by a feature that exists in Windows, Apple added to Panther 
the capability to switch from one user account to another without first 
logging out of the first account. You can keep applications and 
documents open in the first account, switch to another account and 
work in it, then switch back.  

  
NOTE Fast User Switching offers cool eye candy on newer Macs that 

support Quartz Extreme; as you switch, you see one account change 
to another as a 3D cube turns, with each cube face displaying a user 
account. Video cards that support Quartz Extreme currently include 
the NVIDIA GeForce2 MX, GeForce3, GeForce4 MX, and GeForce4 
Ti video cards, or any ATI AGP Radeon card with a minimum of 16 
MB VRAM. The 3D cube effect appears only if both accounts are set 
to the same screen resolution in the Displays pane of System 
Preferences. 

  
Fast User Switching is great for people who share a Mac. Say you’re 
working on your Mac and your spouse or child simply has to check 
his email. Rather than log out and shut down your applications, you 
can switch to his account quickly, he can check his email, and then 
you can switch back to your account and pick up right where you left 
off, saving you a lot of time. 

Turn On Fast User Switching 
To enable Fast User Switching, open the Accounts preference pane, 
click the Login Options button (at the lower left), and check the 
Enable Fast User Switching checkbox. When you turn on Fast User 
Switching, a new menu appears at the far right of your menu bar, 
labeled with the name of the current user and offering commands for 
switching to other user accounts on your Mac or displaying the login 
window. 

  
TIP The User menu that displays in the menu bar is called a menu extra, 

and it is just like all the other icons at the right of the menu bar. You 
can move it by pressing the Command key and dragging it to another 
location in the menu bar. 
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RESOURCES 

Three general troubleshooting books that I recommend you try when 
things go wrong with your Mac are: 

• Macworld Mac Upgrade and Repair Bible, 3rd Edition (Wiley), 
by Todd Stauffer and Kirk McElhearn 
http://www.mcelhearn.com/bible.html 

• Mac OS X Power Tools (Sybex), by Dan Frakes 

• Mac OS X Disaster Relief (Peachpit), by Ted Landau 

And some of the best troubleshooting Web sites are: 

• MacFixit 
http://www.macfixit.com/ 

• MacInTouch 
http://www.macintouch.com/ 

• Mac OS X Hints 
http://www.macosxhints.com/ 

• Apple’s troubleshooting site 
http://www.info.apple.com/ 

• Apple’s troubleshooting discussion forums 
http://discussions.info.apple.com/ 
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SHAMELESS PLUG 

And now, a shameless plug for my 
latest book. 

I worked with Todd Stauffer, the 
author of the first two editions of 
the bestselling Mastering Mac OS 
X, on the third edition of the 
book, which was published in 
December 2003 by Sybex. 

I recommend this third edition to 
anyone who needs coverage of the 
ins and outs of Panther, as well as 
comprehensive information on 
setting up and working with Mac 
OS X 10.3. 

Find out more about this book at 
http://www.mcelhearn.com/panther.html. 
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TAKE CONTROL OF PANTHER: THE SERIES 

Take control of computing with the Take Control series of highly 
practical, tightly focused electronic books! Written by leading 
Macintosh authors, edited by TidBITS, and delivered to your 
electronic doorstep within moments of “going to press,” the Take 
Control ebooks provide just the technical help you need. 
http://www.tidbits.com/takecontrol/ 

 
Other available Take Control ebooks: 

Take Control of Customizing Panther, by Matt Neuburg 
http://www.tidbits.com/takecontrol/panther/customizing.html 

Take Control of Sharing Files in Panther, by Glenn Fleishman 
http://www.tidbits.com/takecontrol/panther/sharing.html 

Take Control of Upgrading to Panther, by Joe Kissell 
http://www.tidbits.com/takecontrol/panther/upgrading.html 

 
With your support, we plan to publish a number of additional ebooks 
in 2004. 
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